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Objekte mit Zoom positionieren

Die Zoomeinstellung über die Statusleiste
Die aktuelle Zoomeinstellung, wird in der Statusleiste angezeigt :

Ein Doppelklick auf den Zoomfaktor öffnet das Fenster „Maßstab“ (siehe Abbildung
3)für die Zoomeinstellung (ein rechter Mausklick öffnet eine eingeschränkte Liste).

Sie können entweder einen neuen Zoomfaktor auswählen oder im Feld „Stufenlos“ 
eingeben, oder Sie verwenden eine der Vorgaben:

• Ganze Seite: Das gesamte Zeichenblatt wird auf dem Monitor abgebildet.

• Seitenbreite: Die senkrechten Seitenränder begrenzen das Monitorbild.

• Optimal: Die Zeichnung (oder das ausgewählte Objekt) wird so vergrößert, 
dass sie (es) den gesamten Bildschirm ausfüllt. 

Die Symbolleiste Zoom

Tipps und Tricks 1

Abbildung 1: Mit Zoom können Objekte wesentlich genauer platziert 
werden.

Abbildung 2: Die Zoomanzeige in der Statusleiste

Abbildung 3: Das Fenster für die Zoomein-
stellungen.

Abbildung 4: Die Zoom-Werte Ganze Seite, Seitenbreite, Optimal
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Diese Symbolleiste (Abbildung 5) bietet zusätzliche Zoomfunktionen. Zum Öffnen kli-
cken Sie in der Symbolleiste Standard auf den kleinen Pfeil neben der Schaltfläche 
Zoom . Sie können die Leiste auch ständig einblenden, indem Sie sie unter An-
sicht > Symbolleisten > Zoom einschalten.

Vergößert das Monitorbild. Erst auf die Schaltfläche klicken, dann auf das Ob-
jekt. Alternativ lässt sich der zu zoomende Bereich als Fenster „aufziehen“.

Verkleinert das Monitorbild. Nur auf die Schaltfläche klicken.

Zoomt Objekte auf Orginalgröße.

Wechsel zwischen den letzten Zoomeinstellungen.

Zoomt Ganze Seite 

Zoomt Seitenbreite 

Zoomt alle Objekte der Zeichnung optimal

Zoomt das ausgewählte Objekt optimal

Die Zeichnung kann innerhalb des Draw-Fensters verschoben werden.

Objekte mit den Fang-Funktionen positionieren
In Draw können Objekte an den Rasterpunkten, an speziellen Fangpunkten, an den 
Fanglinien, am Objektrahmen, an einzelnen Objektpunkten und am Seitenrand „ein-
gerastet“ werden. Diese Funktion wird als Fang bezeichnet. Mit ihr können Objekte 
in einer Zeichnung sehr genau positioniert werden.

Wenn Sie eine Fangfunktion nutzen wollen, sollten Sie immer mit möglichst viel 
Zoom arbeiten. Sie können auch zwei verschiedene Fangfunktionen gleichzeitig nut-
zen (z. B. an Führungslinien und am Seitenrand fangen). Aktivieren Sie aber immer 
nur die Funktion(en), die Sie wirklich benötigen.

Beispiele für den Einsatz der Fangfunktionen finden Sie im Kapitel 10, Fortgeschrit-
tene Zeichentechniken.

Am Raster fangen
Diese Funktion erlaubt es, ein Objekt beim Verschieben exakt auf einen Rasterpunkt 
zu setzen (siehe Abbildung 6). Sie lässt sich über Ansicht > Raster > Am Raster 
fangen und über die Symbolleiste Optionen  ein- und ausschalten.

Das Raster anzeigen
Damit das Raster angezeigt wird, muss es unter Ansicht > Raster > Raster sicht-
bar aktiviert werden. Alternativ kann das Raster auch über die Symbolleiste Optio-
nen mit folgender Schaltfläche an- und ausgeschaltet werden:  .

Tipps und Tricks 2

Abbildung 5: Die Symbolleiste Zoom
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Die Farbe der Raster-Punkte ändern 
Standardmäßig sind die Rasterpunkte hellgrau und daher nur schwer erkennbar. Un-
ter Extras > Optionen > OpenOffice.org > Darstellung kann dies geändert wer-
den (siehe Abbildung 7). 

Gehen Sie im Fenster Benutzerdefinierte Farben in den Bereich Zeichnung/Prä-
sentation und stellen Sie für das Raster eine geeignete Farbe – z. B. schwarz – ein.

Das Raster konfigurieren 
Unter Extras > Optionen > OpenOffice.org Draw > Raster kann die Rasterein-
stellung geändert werden. 

Im Feld Raster sind keine Voreinstellungen nötig, da diese Funktionen jederzeit über 

Tipps und Tricks 3

Abbildung 6: exakt positionieren mit der Funktion am Raster fangen

Abbildung 7: Farbe der Rasterpunkte ändern

Abbildung 8: Das Raster konfigurieren
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die Schaltflächen aufgerufen werden können. 

Auflösung: Bestimmt den horizontalen und vertikalen Abstand zwischen zwei Raster-
punkten (Abbildung 9).

Unterteilung: Gibt an, wie viele Schritte sich zwischen zwei Rasterpunkten befinden. 
Zwischenschritte ermöglichen einen größeren Abstand zwischen zwei Rasterpunk-
ten, wodurch die Zeichnung übersichtlicher bleibt. Objekte können an den Zwischen-
punkten genau wie an den Rasterpunkten gefangen werden.

Die anderen Einstellmöglichkeiten sind weitgehend selbsterklärend. Wichtig ist je-

doch das Drehfeld Fangbereich. Die Rasterpunkte sind genau wie die Führungslinien 
optische Hilfselemente, die von Draw separat verwaltet werden. Wenn Sie eine Fang-
funktion aktiviert haben und ein Objekt verschieben, sucht Draw die Umgebung des 
Objektes nach diesen speziellen Hilfselementen ab, um dort einzurasten. Mit dem 
Fangbereich legen Sie den Suchbereich (Abstand vom Objekt) fest. Wie groß der 
Fangbereich sein soll, hängt von den Gegebenheiten ab (z. B. welche Fangfunktionen 
Sie nutzen, wie das Raster konfiguriert ist, ob es „Kollisionen“ mit anderen Elemen-
ten geben kann), hier müssen Sie im Bedarfsfall ein wenig experimentieren. 

An Fangobjekten (Fanglinien/Fangpunkte) fangen
Fanglinien verlaufen horizontal oder vertikal und werden gestrichelt dargestellt, 
Fangpunkte als kleines Achsenkreuz. 

Achtung !
Bis Version 2.2 von OOo heißen die Schaltflächen in der Symbolleis-
te Optionen „Führungslinien“. Gemeint sind jedoch „Fanglinien“. In 
späteren Versionen wird dies berichtigt sein.

Wenn Sie diese Funktion aktiviert haben, können Sie Objekte daran exakt positionie-
ren. Horizontale und vertikale Fanglinien können auch gleichzeitig genutzt werden. 
Fanglinien sind nach dem Einfügen noch nicht aktiv. Die Fangfunktion kann über die 
Symbolleiste Optionen mit folgender Schaltfläche , oder über das Menü Ansicht 
ein- und ausgeschaltet werden. Wenn die Fanglinien nicht benötigt werden, lassen 
sie sich mit der Schaltfläche  der Symbolleiste Optionen oder über das Menü An-
sicht ein- und ausblenden.

Tipps und Tricks 4

Abbildung 9: Raster mit unterschiedlicher  Auflösung

Abbildung 10: Raster mit Zwischen-
schritten (Unterteilung)
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Eine Fanglinie mit der Maus einfügen
So fügen Sie eine Fanglinie in eine Zeichnung ein:

• Bringen Sie den Mauszeiger auf ein Lineal.

• Drücken und halten Sie die linke Maustaste.

• Ziehen Sie nun die Maus auf das Zeichenblatt, um eine Fanglinie zu erzeugen.

Die Fanglinien können jederzeit mit der Maus verschoben werden. An der Fanglinie 
eingerastete Objekte werden jedoch nicht mit verschoben. 

Fangpunkte und -Linien per Koordinaten einfügen
Der Befehl Einfügen > Fangpunkt/Linie einfügen öffnet ein Fenster mit genauen 
Einstellmöglichkeiten. In dem Feld Art können Sie zwischen einem Fangpunkt oder 
Fanglinien auswählen und im Bereich Position dann die gewünschten Koordinaten 
einstellen. 

Fangpunkte und -linien editieren
Alle Fangobjekte können noch nachträglich bearbeitet werden. Wenn Sie mit der 
rechten Maustaste auf ein Fangobjekt klicken, öffnet sich ein entsprechendes Menü. 
Dieses enthält auch den Befehl zum Löschen.

Tipps und Tricks 5

Abbildung 11: Objekte an Fanglinien (links) bzw. am Fangpunkt 
(rechts) ausgerichtet. Beachten Sie, dass  der Fangpunkt im Prinzip so 
funktioniert, als sei er der Kreuzungspunkt zweier Fanglinien.

Abbildung 12: Fangobjekte per Koor-
dinatenangabe einsetzen
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Fangen an Seitenrändern
Mit dieser Funktion können Sie Objekte am Seitenrand fangen. Auch hier ist die 
Kombination mit Fanglinien und Rasterfang möglich.

Fangen am Objektrahmen
Mit dieser Funktion können Sie ein Zeichenobjekt am Objektrahmen eines anderen 
einrasten lassen. Die „Einrastposition“ kann irgendwo auf dem Objektrahmen liegen. 
Wenn Sie diese Funktion nutzen wollen, sollten Sie den Rasterfang deaktivieren. Ab-
bildung 14 zeigt einige Beispiele dieser Funktion. Beachten Sie bitte, dass der Objek-
trahmen runde Objekte nur an vier Punkten berührt.

Fangen an Objektpunkten
Diese Funktion arbeitet so ähnlich wie die oben beschriebene. Der Unterschied be-
steht darin, dass die Einrastposition nicht mehr irgendwo auf dem Objektrahmen des 
„Zielobjektes“ liegen kann. Es werden sowohl beim zu verschiebenden als auch beim 
Zielobjekt jeweils nur die 4 Eckpunkte des Rahmens berücksichtigt. Das führt dazu , 
dass z. B. bei zwei runden Objekten die Fangpunkte überhaupt nicht zu einem Objekt 
zu gehören scheinen, wie bei den rot markierten Fangpunkten in Abbildung 15  gut 
zu sehen ist. 

Tipps und Tricks 6

Abbildung 13: Objekt an den Seitenrändern ausge-
richtet

Abbildung 14: Objekt am Rahmen eines anderen ausrichten
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Objekte mit Hilfslinien positionieren 
Zum Vereinfachen der Ausrichtung von Objekten können Hilfslinien sichtbar ge-
macht werden, die die Kanten eines Objektes verlängern, während es verschoben 
wird. Diese Hilfslinien haben aber keine Fangfunktion.

Die Hilfslinien können unter Extras > Optionen > OpenOffice.org Draw > An-

sicht (de)aktiviert werden oder einfach durch Anklicken der Schaltfläche  auf der 

Symbolleiste Optionen.

Maßstäbliches Zeichnen

In Draw erstellen Sie Ihre Zeichnungen grundsätzlich auf einem vorher definierten 
Zeichenblatt. Dies wird meistens das Format DIN A4 haben, damit es auf einem 
„Standarddrucker“ ausgegeben werden kann. Je nach der tatsächlichen Größe des zu 
zeichnenden Objektes wird daher oft eine maßstäbliche Verkleinerung oder Vergrö-
ßerung sinnvoll oder notwendig. Den gewünschten Maßstab können sie unter Extras 
> Optionen > Draw > Allgemein einstellen.

Der Maßstab und die gewählte Maßeinheit werden automatisch auf die Lineale und 
das Fenster Position und Größe übertragen. Wenn Sie öfter maßstäbliche Zeichnun-
gen anfertigen wollen, empfiehlt sich die Verwendung entsprechender Seitenvorla-
gen, damit Sie die notwendigen Einstellungen nur einmal vornehmen müssen.

Ob Sie im Maßstab 1 : 1 oder in einem anderen zeichnen, an der Bedienung des Pro-

Tipps und Tricks 7

Abbildung 15: Objekte an den Objektpunkten eines anderen 
Objektes ausrichten

Abbildung 16: Arbeiten mit Hilfsli-
nien



Maßstäbliches Zeichnen

gramms ändert sich dadurch nichts. Durch die Vorgabe eines Zeichnungsmaßstabes 
nimmt Draw Ihnen aber das sonst notwendige Umrechnen komplett ab. Die Maße 
werden immer nach den eingestellten Werten umgerechnet und angezeigt, auch 
beim Bemaßen. Die Rastermaße werden vom Zeichenmaßstab nicht beeinflusst, da 
sie keine Zeichnungselemente, sondern eine optische Zeichenhilfe sind.

Anmerkung
Wenn Sie Elemente in eine Zeichnung einfügen (aus der Gallery 
oder der Zwischenablage), sollten diese im selben Maßstab gezeich-
net sein, damit die Größenverhältnisse stimmen.

Komplexe Zeichnungen auf mehrere Ebenen 
verteilen

Ebenen sind wie transparente Folien, die man übereinander auf einen Tageslichtpro-
jektor legt. Bei Bedarf kann man einzelne Folien herausnehmen oder hinzufügen. So 
kann z. B. bei einer Bauzeichnung der Grundriss auf einer solchen Folie gezeichnet 
sein, die Rohrleitungen der Heizung auf einer anderen und die Elektroinstallation auf 
einer dritten. Gerade bei komplexen Zeichnungen bietet diese Ebenentechnik viele 
Vorteile, da man die gerade nicht benutzten Ebenen ausblenden oder vor unbeab-
sichtlichten Veränderungen durch Sperren schützen kann. 

In Draw sind standardmäßig bereits drei Ebenen eingerichtet : Layout, Controls, und 
Maßlinien.

Um die Ebene zu wechseln, klickt man auf den entsprechenden Ebenenreiter. Alles 
was nun gezeichnet wird, wird auf dieser Ebene eingetragen. Die Standard-Ebene ist 
Layout. Sie ist aktiv, wenn Sie eine neue Zeichnung beginnen. Die Ebene Controls ist 
für Kontrollelemente wie z. B. Schaltflächen reserviert und sollte nicht für normale 
Zeichenelemente benutzt werden. Die Ebene Maßlinien nimmt in der Voreinstellung 
Zeichenobjekte des Typs „Maßlinie“ auf. Mit dem Befehl Einfügen > Ebene kann 
eine neue Ebene in die Zeichnung eingefügt werden (Abbildung 17 links).

Klickt man mit der rechten Maustaste auf einen der Ebenenreiter, öffnet sich ein 
Menü. Hier können sie wählen, ob eine Ebene eingefügt, geändert, umbenannt oder 
gelöscht werden soll.1

Jeder Ebene können Eigenschaften zugeordnet werden:

• Sichtbar: Wenn Sie diese Eigenschaft nicht aktivieren, wird diese Ebene nicht 
angezeigt. (Die Folie wird aus dem Stapel gezogen)

1 Bei den von Draw vorgegebenen Ebenen (Layout, Control, Masslinien) können nur die Eigenschaften 
geändert werden. Sie können jedoch nicht gelöscht werden.

Tipps und Tricks 8

Abbildung 17: Ebenen einfügen und ändern
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• Druckbar: Hier bestimmen Sie, ob diese Ebene gedruckt werden soll oder 
nicht. Es ist z. B. oft sinnvoll, eine Ebene für Varianten, Entwürfe, Notizen und 
Ähnliches zu reservieren. Diese Ebene muss aber nicht immer ausgedruckt 
werden.

• Gesperrt: Alle Objekte dieser Ebene sind geschützt. Sie können nicht gelöscht, 
verändert oder verschoben werden. Einer gesperrten Ebene können auch kei-
ne Objekte hinzugefügt werden. Bei einer Bauzeichnung würde man z. B. die 
Ebene mit dem Grundriss sperren und dann auf einer neuen Ebene die Elektro-
Installation zeichnen. 

TIPP

Etwas verwirrend ist die Tatsache, dass man Objekte einer Ebene 
verschieben kann, obwohl man auf einer anderen arbeitet. Um ein 
Objekt vor versehentlichen Löschen oder Verschieben zu schützen, 
legen Sie es daher am besten auf eine gesperrte Ebene.

Eine Beispielzeichnung (Grundriss + Möbel)
Eine beliebte Anwendung für Programme wie Draw ist das „Möbel schieben“. Der 
Grundriss eines Zimmers oder einer Wohnung lässt sich mit Draw leicht zeichnen. 
Am Einfachsten wird es, wenn Sie die Wände als dickere Linie zeichnen. Sie können 
diese aber auch aus einzelnen Rechtecken oder Polygonen zusammensetzen und 
dann verschmelzen (Kontextmenü) und mit einer Schraffur füllen. Bevor Sie zur Tat 
schreiten, sollten Sie den Abschnitt „Maßstäbliches Zeichnen“ auf Seite 7 gelesen ha-
ben.

Für dieses Beispiel eignet sich die Maßeinheit Zentimeter. Der Zeichnungsmaßstab 
und die Rastereinstellungen ergeben sich aus der Größe des Grundrisses. 

Mit dem Feld Position und Größe können Sie die einzelnen Wände sehr schön positio-
nieren und dimensionieren. Achten Sie darauf, dass sich die Rechtecke vollständig 
überlappen (siehe Abbildung 18), da sonst beim Verschmelzen unschöne Kanten ent-
stehen.

Tipps und Tricks 9

Abbildung 18: Wandecke aus zwei Rechtecken zusammengesetzt. 
Von oben nach unten: vor, nach dem Verschmelzen, schraffieren.
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Abbildung 19 zeigt den fertigen Grundriss. Zusätzlich wurde eine Kommode einge-
fügt. Der Korpus der Kommode wurde auf die Ebene Layout gelegt, die herausgezo-
gene Schublade und die geöffneten Türen bilden eine Gruppe und liegen auf einer ei-
genen Ebene. 

Durch Anzeigen oder Ausblenden dieser Ebene lassen sich nun die Türen und Schub-
laden „schließen“ und „öffnen“. Ausgeblendete Ebenen werden farbig gekennzeich-
net (siehe Abbildung 20 ).

Achtung !

Wenn Sie ein Zeichenobjekt in die Zwischenablage oder in die Galle-
ry kopieren, gehen alle Ebenen außer den drei Standard-Ebenen 
(Layout, Controls, und Maßlinien) verloren und alle Objekte werden 
beim Einfügen in ein neues Draw-Dokument der Ebene „Layout“ zu-
geschlagen. Die Rekonstruktion der Ebenen wird erleichtert, wenn 
Sie vorher die Objekte einer Ebene zu einer Gruppe zusammenfas-
sen.

Tipps und Tricks 10

Abbildung 19: Grundriss mit Kommode

Abbildung 20: Ein- und Ausblenden von Ebe-
nen
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Die Ebene eines Zeichenobjekts wechseln
Draw hat keinen direkten Befehl zum Ändern der Ebene. Wenn die Zeichenebene ge-
ändert werden soll, wechseln Sie einfach auf die neue Ebene, wählen das entspre-
chende Objekt an, schneiden es aus und fügen es sofort wieder ein. Wenn Sie dabei 
die Statusleiste (hier das Infofeld) beobachten, können Sie die Änderung gut verfol-
gen und überprüfen. Sie können auch auf das Objekt klicken, die Maustaste ca. zwei 
Sekunden gedrückt halten bis das Objekt in die Zwischenablage übernommen wurde 
und es dann auf die Registerlasche der Zielebene ziehen.

Mehrseitige Dokumente

Auch Draw-Dokumente können wie Präsentationen aus mehreren Seiten bestehen. 
Wie in Impress stehen Ihnen auch in Draw für die Verwaltung der Seitenbereich und 
für eine einheitliche Gestaltung Hintergrundseiten zur Verfügung.

Seitenbereich
Standardmäßig ist der Seitenbereich links ange-
dockt. Er zeigt zu jeder Seite ein verkleinertes 
Bild. Wählen Sie ein Bild dort aus, wird die ent-
sprechende Seite in der Mitte gezeigt und mit 
einem Klick auf die Seite zum Bearbeiten akti-
viert.

Das Seitenbereich-Fenster verhält sich ähnlich 
wie das Formatvorlagen-Fenster. Ziehen Sie an 
der grauen Trennlinie um die Breite des Seiten-
bereichs zu verändern. Klicken Sie auf die Mitte 
dieser Trennlinie um den Seitenbereich aus- und 
wieder einzublenden. Doppelklicken Sie bei ge-
drückter Strg-Taste auf den oberen grauen Be-
reich, um das Fenster an- und abzudocken.

Im Seitenbereich ändern Sie durch Ziehen mit 
gedrückter Maustaste die Reihenfolge der Sei-
ten; ein schwarzer Querstrich zeigt Ihnen die 
Einfügeposition.

Tipps und Tricks 11



Mehrseitige Dokumente

Über das Kontextmenü fügen Sie neue Seiten 
ein, löschen Seiten oder erstellen über Kopieren 
– Einfügen Duplikate.

Die Seiten werden automatisch mit „Folie 1“, „Folie 2“ usw. benannt. Diese Bezeich-
nung ist relativ; wenn Sie die Seite „Folie 1“ um eine Position nach hinten verschie-
ben, erhält sie automatisch die Bezeichnung „Folie 2“. Wollen Sie den Seiten feste, 
spezifische Bezeichnungen geben, müssen Sie die Seiten selbst benennen. Seitenna-
men sind nützlich für die Arbeit mit dem Navigator und wenn Sie einzelne Seiten 
über Einfügen > Datei in andere Dokumente einfügen möchten.

Hintergrundseiten benutzen
Mit Hintergrundseiten legen Sie gemeinsame Seitengestaltungen für mehrere Seiten 
des Draw-Dokuments fest. Dazu gehören die Gestaltung des Hintergrunds mit Far-
ben oder Grafiken, auf allen Seiten sichtbare Hintergrundobjekte sowie Feldbefehle 
wie Seitennummer und Autor.

Anmerkung

Die Bezeichnungen sind in diesem Bereich noch nicht vollständig 
überarbeitet, sodass die Begriffe Folie – Dia – Seite sowie Master – 
Hintergrund – Seitenvorlage noch durcheinander benutzt werden. 
Wenn Sie in der Hilfe suchen, sollte Sie daher auch alternative 
Suchbegriffe einsetzen.

Hintergrundseite gestalten
Wechseln Sie mit Ansicht > Master zu der Masteransicht, es öffnet sich die zugehö-
rige Symbolleiste Master-Ansicht. Wenn nicht, kann sie über Ansicht > Symbolleis-
ten aktiviert werden. In dieser Leiste finden Sie Schaltflächen zum Anlegen neuer 
Hintergrundseiten und zum Umbenennen. Die gleichen Funktionen erreichen Sie 
auch über das Kontextmenü eines Seitenbildes aus dem Seitenbereich der Master-
Ansicht. Die Schaltfläche Masterseite löschen ist nur aktiv, wenn Sie im Seitenbe-
reich eine Hintergrundseite auswählen, die keiner Seite zugewiesen ist.

Um in den Normalmodus zurückzukehren, benutzen Sie die Schaltfläche Master 
View schließen oder Ansicht > Normal.

Sie können solche Hintergrundseiten wie normale Seiten bearbeiten. Über Format > 
Seite > Hintergrund legen Sie Farben, Muster oder Hintergrundbild fest. Diese 
Einstellungen sind für jede Hintergrundseite individuell. Sie können in der Master-
Ansicht auch die Abmessung und die Orientierung der Seite festlegen; solche Einstel-
lungen gelten aber für alle Seiten einheitlich.

Wenn Sie Zeichenobjekte auf eine solche Hintergrundseite einfügen, werden diese 
später auf allen Seiten zu sehen sein, denen diese Hintergrundseite zugeordnet ist. 
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Abbildung 21: Symbolleiste



Mehrseitige Dokumente

Dies ist eine sinnvolle Option, um zum Beispiel alle Zeichnungen mit einem Firmenlo-
go zu versehen.

Masterseiten sind wie normale Seiten auch in Ebenen organisiert. Den Ebenen der 
normalen Seiten ist jeweils eine entsprechende Ebene der Masterseite zugeordnet. 
Dabei werden die Ebenen Layout/Control/Maßlinien als eine Einheit betrachtet; ih-
nen ist die Masterseiten-Ebene „Hintergrundobjekte“ zugeordnet.

Über Einfügen > Feldbefehl können Sie Datum, Uhrzeit, Seitennummer, Autor und 
Dateiname einfügen. Weitere Feldbefehle stehen nicht zur Verfügung. Bei der Seiten-
nummer wird keine feste Nummer eingefügt, sondern eine Variable; erst bei der Sei-
te selbst erscheint die konkrete Nummer gemäß der Position der Seite. Sie passt sich 
beim Verschieben der Seite automatisch an.

Hintergrundseite zuweisen und verwalten
Wählen Sie aus dem Kontexmenü der Seite den Eintrag Seite> Foliendesign (siehe 
Abbildung 22). Es öffnet sich der Dialog Seitenvorlage mit einer Auswahl der in dem 
Dokument zur Verfügung stehenden Hintergrundseiten.

In der Statusleiste sehen Sie rechts unten, welche Hintergrundseite aktuell zugewie-
sen ist. Mit einem Doppelklick auf dieses Feld können Sie ebenfalls den Dialog Sei-
tenvorlage öffnen.

Achten Sie in dem Dialog auf die Option Hintergrundseite austauschen. Wenn diese 
markiert ist, wird die ausgewählte Hintergrundseite auf alle Seiten des Dokuments 
angewendet, nicht nur auf die gerade aktive Seite.
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Abbildung 22: Befehle im Untermenü Seite

Abbildung 23: Dialog Seitenvorlage



Mehrseitige Dokumente

Die Option Nicht verwendete Hintergrundseiten löschen wirkt zurzeit nicht ganz kor-
rekt. Egal ob sie markiert ist oder nicht, werden beim Laden von Hintergrundseiten 
und beim neuen Zuweisen die sonstigen, keiner Seite zugewiesenen Hintergrundsei-
ten automatisch gelöscht. Weisen Sie daher eine Hintergrundseite erst einer Seite 
zu, bevor Sie eine weitere Hintergrundseite erstellen oder laden.

In diesem Dialog können Sie auch früher schon erstellte Hintergrundseiten laden. 
Geeignet sind dafür alle Draw- und Impress-Dokumentvorlagen. Von Impress-Doku-
menten können die dortigen speziellen Masterelemente aber nicht übernommen wer-
den, sondern nur der eigentliche Hintergrund.

Es gibt keine spezielle Option, Hintergrundseiten als Vorlage zu speichern. Statt des-
sen legen Sie ein Dokument mit den gewünschten Hintergrundseiten an und spei-
chern dieses Dokument mit Datei > Vorlagen > Speichern als Dokumentvorlage.

Farbtabelle: Einzelne Farben ändern oder 
hinzufügen

Draw benutzt (wie alle OpenOffice.org-Programmmodule) für die Darstellung von 
Farben eigene Farbtabellen. Dadurch haben Sie die Möglichkeit, die Farbausgabe Ih-
ren Bedürfnissen anzupassen. Sie können bestehende Farben innerhalb einer Tabelle 
anpassen, Farben hinzufügen und neue Farbtabellen erstellen.

Sie erreichen diese Option über Extras > Optionen > OpenOffice.org > Farben 
oder über Format > Fläche > Register Farben (siehe Abbildung 25). Der Weg 
über das Flächenformat bietet die Möglichkeit, Farbtabellen zu laden oder zu spei-
chern. Die Änderungen beziehen sich immer auf die gerade aktive Farbtabelle.

OpenOffice.org benutzt für Farben intern immer das RGB-Farbmodell. Für die Defini-
tion eines Farbwertes stehen Ihnen jedoch unterschiedliche Eingabemethoden zur 
Verfügung. Die Umrechnung ins RGB-Modell erfolgt automatisch. 

Direkt auf der Seite können Sie den Farbwert durch Zahlenwerte eingeben. Wählen 
Sie in der Auswahlliste zwischen den Farbmodellen RGB (Grundfarben Rot, Grün, 
Blau) oder CMYK (Grundfarben Cyan, Magenta, Yellow und Schwarz). 

TIPP
Informationen über Farbmodelle finden Sie unter: http://de.wikipe-
dia.org/wiki/Farbraum

Die einzelnen Farbtöne werden durch unterschiedliche Farbanteile ihrer Grundfar-
ben erzeugt. Die Farbanteile können im RGB-Modell aus einer Skala von 0 bis 255 
gewählt werden. Zum Beispiel hat die Farbe „Rot 3“ unter dem Modell RGB einen ro-
ten Farbanteil von 184, einen grünen von 71 und einen blauen von 0. Das CMYK-Mo-
dell benutzt Prozentangaben.
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Abbildung 24: Dialog Seitenvorlage laden



Farbtabelle: Einzelne Farben ändern oder hinzufügen

Durch das Verändern dieser Anteile manipulieren Sie den Farbton. Tragen Sie den 
Zahlenwert direkt in das Feld ein oder benutzen Sie das Drehfeld am rechten Rand 
des Zahlenfeldes. Die Veränderungen werden in dem unteren der beiden Farbfelder 
sofort angezeigt (Abbildung 25).  Durch Klicken auf die Schaltfläche „Ändern“ wer-
den die neuen Einstellungen übernommen und gespeichert. 

Sie können der aktuellen Tabelle auch neue Farben hinzufügen. Tragen Sie im Einga-
befeld Name eine Bezeichnung für den neuen Farbton ein und legen Sie dann die 
Farbanteile fest. Klicken Sie danach auf die Schaltfläche Hinzufügen. Die neue Farbe 
wird nun am Ende der Farbtabelle eingetragen und in der Farbtabelle gespeichert. 

Wenn Ihnen eine Farbe nicht mehr gefällt, können Sie sie auch löschen. Dazu brau-
chen Sie die entsprechende Farbe nur auszuwählen und dann auf die Schaltfläche 
Löschen zu klicken. 

Wenn Sie auf die Schaltfläche Bearbeiten klicken, öffnet sich ein spezieller Dialog 
zum Erstellen eigener Farben (siehe Abbildung 26), der Ihnen sehr viel mehr Einga-
bemöglichkeiten bietet.

Im unteren Bereich befinden sich Einstellmöglichkeiten für die bereits bekannten 
Farbmodelle CMYK und RGB und zusätzlich für das Modell HSB2/FSH. 

Von den beiden Kontrollfeldern rechts unten zeigt das linke die vorher markierte Far-
be an, das rechte die aktuell eingestellte Farbe. 

Die Farbfenster im oberen Berich erlauben eine direkte Farbauswahl ohne Kenntnis 
von Zahlenwerten.

2Auch in deutschsprachiger Literatur wird nur die Abkürzung HSB benutzt.
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Abbildung 25: Das Register Farben im  Menü Fläche 



Farbtabelle: Einzelne Farben ändern oder hinzufügen

Wenn Sie auf den Schalter OK klicken, wird das Farbfenster wieder geschlossen und 
das Ausgangsfeld wieder aktiv. Sie können nun der selbst definierten Farbe – wie 
oben beschrieben – einen neuen Namen geben und sie dann durch Anklicken der 
Schaltfläche Hinzufügen speichern. Sie können die alte Farbe aber auch überschrei-
ben, indem Sie auf Ändern klicken. Die alte Farbe wird dann (ohne Warnhinweis) 
überschrieben. 

Farbauswahl-Dialog benutzen

Variante 1:
Sie können die aktuelle Farbe ändern, indem Sie die einzelnen Farbwerte verändern. 
Dabei können Sie beliebig zwischen den  Farbmodellen springen. Die Enstellungen 
werden immer in das RGB-Modell umgerechnet, wodurch Ihre Eingaben mitunter et-
was angepasst werden.

Bei dem Farbmodell HSB/FSH wird der Farbton über die 
drei Parameter Hue/Farbe (mögliche Werte von 0 bis 
359), Saturation/Sättigung (mögliche Werte von 0 bis 100) 
und Brightness/Helligkeit (mögliche Werte von 0 bis 100) 
definiert. Die Zahlenwerte für die Farbe sind Gradanga-
ben in einem Farbkreis, die anderen beiden sind Prozent-
angaben.

Variante 2
Sie können aber auch eine neue Farbe auswählen, indem Sie im rechten oberen 
Farbfenster auf den gewünschten Farbton klicken. Die ausgewählte Farbe ist durch 
einen Rahmen gekennzeichnet. Diesen können Sie mit der Maus beliebig verschie-
ben. Wenn Ihnen dies zu ungenau wird, können Sie die „Feineinstellung“, wie unter 
Variante 1 beschrieben, durch Änderung der Zahlenwerte in den Farbmodellen vor-
nehmen. Dieses Farbfeld ist direkt mit den Drehfeldern des HSB/FSH-Bereichs ge-
koppelt.
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Abbildung 26: Farbauswahl-Dialog



Farbtabelle: Einzelne Farben ändern oder hinzufügen

Zum besseren Verständnis dieses Farbfeldes schieben 
Sie den oben erwähnten Rahmen bitte einmal von ganz 
links nach ganz rechts und beobachten Sie dabei die 
Zahlenfelder im Farbmodell HSB. Wie Sie sehen, än-
dert sich der Farbwert dabei von seinem Minimum zum 
Maximum. Das Gleiche geschieht mit dem Wert für die 
Sättigung, wenn sie den Rahmen von unten nach oben 
schieben. Der Wert für die Helligkeit bleibt unverän-
dert, egal wie Sie den Rahmen verschieben. Diesen 
Wert können Sie nur über das Drehfeld am rechten 
Rand des Zahlenfeldes ändern.

Variante 3
Das linke Farbfeld ist schachbrettartig in acht mal acht Einzelfelder unterteilt. Wich-
tig sind die Farben in den 4 Eckfeldern. Die Farbe Rot ändert sich in der ersten Zeile 
stufenweise in Grün und in der ersten Spalte stufenweise in Gelb. Die Farbe Grün 
wiederum ändert sich in der achten Spalte stufenweise in Blau. Dieses Fenster ent-
hält also abgestuft, das Farbspektrum zwischen den vier „Hauptfarben“ in den Eck-
punkten. Wenn Sie die Maus auf ein Farbfeld schieben, werden die RGB-Werte dieses 
Farbfeldes als Tooltipp angezeigt. Das gelbe Eckfeld links unten hat z. B. die RGB-
Werte 255, 255, 0. (Vollen Rot-Wert, Vollen Grün-Wert, kein Blau). 

Klicken Sie bitte auf dieses Feld. Es bekommt dann einen Rahmen. Wenn Sie nun auf 
den Pfeil --> (unter den Farbtabellen) drücken, wird die ausgewählte Farbe übernom-
men (siehe folgende Abbildung).

Sie können das linke Farbfeld aber auch noch verändern, indem Sie die Farbe eines 
Eckpunktes ändern. Markieren Sie dazu zuerst den zu ändernden Eckpunkt per 
Mausklick. Wählen Sie dann den gewünschten Farbton im rechten Farbfeld. Bei Be-
darf können Sie diesen auch noch über die Zahlenfelder der Farbmodelle „justieren“. 

Wenn Sie nun auf den Pfeil <--  klicken, wird der ausgewählte Farbton auf den mar-
kierten Eckpunkt übertragen und Sie erhalten ein neues Farbfeld.
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Abbildung 27: Veränderung der Farbe eines Eckpunkts



Raffinierte Effekte

Raffinierte Effekte

Duplizieren

Duplizieren setzt Kopien des gewählten Objektes in die Zeichnung ein. Die Form der 
Kopien kann dabei kontinuierlich abgewandelt werden. Um diesen Befehl zu starten, 
muss zuerst das Ausgangsobjekt angewählt werden. Dies kann ein einzelnes Objekt 
oder eine Gruppe von Objekten sein. Danach kann das Menü Duplizieren unter Bear-
beiten > Duplizieren aufgerufen werden. 

Hier können Sie die Anzahl der Kopien eingeben und die gewünschten Veränderun-
gen festlegen. Abbildung 29 zeigt die Wirkung des Befehls. Die linke Fläche wurde 
mit den in Abbildung 28 eingegebenen Werten dupliziert. 
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Abbildung 29: Der Befehl „Duplizieren“

Abbildung 28: Das Menü Duplizieren



Raffinierte Effekte

Überblenden

Überblenden lässt zwei verschiedenen Konturen schrittweise ineinander übergehen. 
Das Ergebnis ist eine Gruppe von Objekten mit den Ausgangsobjekten als Start- bzw. 
Endpunkt. Dazwischen liegen dann die einzelnen Übergangsschritte. 

Um den Befehl zu starten, müssen zuerst die beiden Ausgangsobjekte angewählt 
werden. Danach kann das Menü mit den Einstell-Möglichkeiten aufgerufen werden: 
Bearbeiten > Überblenden. 

Im Regelfall braucht nur die Anzahl der Zwischenschritte eingetragen zu werden. Ab-
bildung 32 zeigt die Objekte aus Abbildung 30 nach der Überblendung mit den Vor-
gaben aus Abbildung 31 . 

Welches Objekt soll vorn liegen.?
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Abbildung 30: Die beiden Ausgangsobjekte für die Überblen-
dung

Abbildung 31: Das Menü Überblenden

Abbildung 32: Überblendung mit 6 Schrit-
ten



Raffinierte Effekte

Wie bekomme ich diese Variante    und nicht diese   ?

Bevor Sie den Befehl zum Überblenden aufrufen, können Sie festlegen, welches Ob-
jekt vorn liegen soll.

Wenn Sie diese Variante  wollen, dann klicken Sie mit der rechten Maustaste 

auf das    (das Objekt, das vorn liegen soll) und wählen Anordnung > Ganz 

nach vorn (Strg + Umschalttaste + +). Oder Sie wählen  (das Objekt, das hin-
ten liegen soll) und wählen Anordnung > Ganz nach hinten (Strg + Umschalt-
taste + –).
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